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Chapter 4

. ILWIS objects

4.1 Data objects

ILWIS data objects are maps, tables and columns; that is the GIS material to work
with. Data objects can be created, edited, displayed, etc., and most important
operations can be performed on them. Except for columns, data objects in the
current directory are listed in the Catalog by a name and an icon.

Data objects are:
raster maps (containing pixels)
polygon maps (containing closed area features)
segment maps (containing line features)
point maps (containing point features)
map lists (containing a set of raster maps)
tables (containing columns)
columns (not listed in Catalog)

Each data object (a map, table or column) has a domain in which the valid IDs,
Class names, values etc. of the object are defined. Other service objects that a data
object may need are for instance a representation, a georeference, or a coordinate
system. For more information on relations between ILWIS objects, see Help topic
Appendices : relations between ILWIS objects.

Object names should start with a character from A to Z. For the other characters in
an object name, you are allowed to use: characters A through Z, numbers 0 through
9, and underscores. Except for column names, object names cannot exceed 8
characters.

F To select the type of objects shown in the Catalog, use the Catalog command on the
Options menu of the Main window. See also Help topic How to customize the
Catalog.

F To copy or delete ILWIS objects, you MUST:
n use the Copy Object or Delete Object commands on the Edit menu of the Main

window, or
n choose the Copy or Delete commands on the context-sensitive menu which

appears when clicking with the right mouse button on an object in the Catalog.

It is strongly discouraged to copy, delete or rename files in DOS or in the File
Manager.
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4.1.1 Introduction on maps
A map contains certain features and refers to the geographic position of those
features:

point maps: a point map contains point features;
segment maps: a segment map contains line features;
polygon maps: a polygon map contains closed area features; and
raster maps: a raster map contains pixels. In ILWIS, most spatial operations
are performed on raster maps.

When using satellite images, you already have raster maps. Pixels in a satellite
image have values ranging from 0 to 255, although not every value may occur in
your image. In ILWIS, satellite images are stored with domain Image.

When starting from an analog paper map, you start by:
n digitizing point features of interest with the point editor,
n digitizing line features of interest with the segment editor, and/or
n digitizing areas of interest with the polygon editor.

Afterwards, point, segment and polygon maps can be rasterized into a raster map.
Before you begin to digitize, you have to know that features in any map can be
identified in the following manner:
n by ID: each feature is identified by its own name or number; each 

feature occurs in general only once in the map;
n by Classes: features are identified by their class name; features may occur 

in several places in the map;
n by Value: features are identified by a measurable value.
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The following scheme illustrates the above:

Map type: Features in map: Identification
of features
by:

Example:

Point map ∗ Points: indiv. sample points
∗ Points: classes of farms
∗ Points: height information

IDs
Class names
Values

1,2,3
small farm, large farm
500, 600, 700 (m)

Segment
map

∗ Lines: individual rivers
∗ Lines: classes of roads
∗ Lines: isolines for height

IDs
Class names
Values

...
prim. roads, sec. roads
500, 600, 700 (m)

Polygon
map

∗ Areas: indiv. cadastral plots
∗ Areas: land use classes
∗ Areas: concentration values

e.g. air pollution (NO2, SO2)

IDs
Class names
Values

plot 234a, plot 345b
rice, maize, forest
1000, 2000, 5000
(mol/ha/y)

Raster map ∗ Pixels: rasterized points,
lines or areas with IDs

∗ Pixels: rasterized points,
lines, or areas with class
names

∗ Pixels: rasterized points,
lines or areas with Values

∗ Pixels: value outcome of
calculations

IDs

Class names

Values

Values

plot 234a, plot 345b or
river...
rice, maize, forest

values

any value

Raster map ∗ Pixels (satellite images) pixel values:
0 to 255

-

The user-defined collection or set of IDs, Class names or values that may be used in
a map is called the domain of a map. In ILWIS, we speak of maps of the ID, Class
or Value type, meaning that the elements in that map are either identified by IDs,
Class names or values.

Only maps with features identified by IDs or Class names can have attributes; i.e.
extra information about the point, segment, polygons or mapping units, in so-called
attribute tables. When creating an attribute table, this table should have the same
domain as your ID or Class map. Afterwards you can add extra columns with the
attribute information.

The Class names (or Identifiers) in a domain type Class (or a domain type
Identifier) provide the relational link between the units in a map and the records in
a table.

Maps containing values, for example a satellite image or a height map, cannot have
attributes in an attribute table.

4.1.2 Raster maps 
A raster map is a data object used to store spatial geographic information and
remote sensing data as pixels (picture elements) of a certain size, e.g. 20 x 20 m.
These pixels are either codified by IDs, class names, values or colors; this is
determined by the domain of the map. The relation between pixels in a raster map
and the position on earth is defined by the georeference that the raster map is using.
Raster maps can be displayed in a map window, and can be edited with the pixel
editor.
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You can calculate with raster maps (MapCalc) and you can perform many other
raster and image processing operations on them such as: Filter, Cross, Distance
calculation, etc. In ILWIS, most spatial operations are performed on raster maps.

A raster map can be obtained:
n by importing an existing raster map from ILWIS version 1.41,
n by rasterizing an existing point, segment, or polygon map,
n by creating a new raster map and editing its pixels with the pixel editor,
n by using a satellite image which is already a raster map,
n by scanning a map or photograph and importing it into ILWIS.

As mentioned above, the output of spatial operations is usually another raster map.
When working with the multi-spectral bands of a satellite image or with multiple
raster map of a time series, you can combine these bands or maps into a map list.

Contents of a raster map and location of pixels
The contents of a raster map are defined by the domain that the raster map is using.
A raster map may store for example:
n rasterized individual point, segment or polygon features codified by IDs for

instance cadastral plot IDs; the map uses an ID domain,
n rasterized classes of point, segment, or polygon features codified by class names,

for example land use classes; the map uses a class domain,
n rasterized point, segment or polygon values for example height values; the map

uses a value domain,
n reflection values in case of satellite images; the maps use the Image domain, the

NOAA domain, or the Radar domain,
n true or false pixels; the map uses the Bit domain,
n true, false or undefined pixels; the map uses a Bool domain,
n colors in case of a scanned picture that was imported into ILWIS; the map uses

a Picture domain, or the Color domain,
n output values after a map calculation (any domain),
n output values (any domain) after performing an operation, e.g. classes after the

Classify operation (image classification), or values after a Distance calculation,
or colors after creating a Color Composite,

n attribute values (any domain) when an attribute map was created from an
attribute table,

n classified values, when a value map was classified (a group domain) with the
Slicing operation.

For more information on domains, refer to Basic concepts : working with domains.

The spatial location of the pixels in a raster map is defined by the georeference that
the raster map is using.

For maps using a class or ID domain, you can create an attribute table which stores
additional information on the classes or IDs in the map. Use the same class or ID
domain for the attribute table as you used for the map. Then, add the attribute
columns to the table. To create an attribute table, refer to How to create an attribute
table.
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The colors in which a map appears on the screen are stored in a representation. For
maps that use a class domain or a value domain, you can create you own
representation. For value maps, there are also a number of system representations
available. For maps that use an ID, Bit, or Bool domain, you have to specify colors
each time you display the map.

Names of raster maps
Any raster map name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.

To create a raster map
Usually, you have to rasterize a point, segment or polygon map with the Points to
Raster, Segments to Raster or Polygons to Raster operation. In the Rasterize
process, you have to specify the dimensions of the raster map's pixels in the
georeference of the raster map.

To display a raster map
The easiest way to display a raster map is to double-click the map in the Catalog. A
Display Options dialog box appears, in which you can specify how the map should
be displayed in a map window. For other display methods, see How to open objects.

To edit a raster map
You can edit a raster map by clicking it with the right mouse button in the Catalog
and subsequently choose Edit from the context-sensitive menu. When a raster map
is already displayed in a map window, you can also choose the Edit Layer
command from the Edit menu in the map window. For other methods, see How to
edit point, segment, polygon and raster maps.

Raster maps are edited with the Pixel editor; you can edit the class names, IDs, or
values of the pixels in the raster map. Dependent raster maps and read-only raster
maps cannot be edited.

Operations on raster maps
You can calculate with raster maps by typing a Map Calculation formula on the
command line of the Main window or in the Map Calculation dialog box. When the
definition symbol = is used in a calculation, the output map is dependent.

You can also perform other operations on a raster map by selecting an operation
from the Operation-list or from the Operations menu (for other methods, see How
to start operations). Subsequently, fill out the appearing dialog box of that operation
and click the OK button; this generates an ILWIS expression on the command line.
Output objects that are obtained through an operation's dialog box are always
dependent.

Advanced users can type the complete ILWIS expressions on the command line of
the Main window or create a script to execute a series of expressions. For more
information, see Appendices : ILWIS expressions.
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When the output map of a calculation or another operation uses a value domain,
you can usually define a value range and precision for the output map, see below.
Operations on raster maps are for instance Filter, Cross and Distance calculation.
For more information on dependent maps, see Basic concepts : dependent data
objects. For more information on operations, refer to ILWIS operations.

Technical information
A raster map consists of an ASCII object definition file (.MPR) and a binary data
file (.MP#). The object definition file contains further references to the domain and
the georeference that the raster map is using; these are properties of a raster map.

By viewing the properties of a raster map, you can see whether the map is
dependent or not, which other objects the map is using, etc. For dependent maps,
you can also manage dependencies: break dependencies, make dependent maps up-
to-date, delete the dependent map's data file, etc.
For more information, see Basic concepts : properties of objects.

The IDs, class names or values of pixels are stored line by line, starting from the
first pixel (left) on the first line in the map (up), to the last pixel in the last line.
Raster maps are stored as bit, byte, 2-byte, 4-byte or 8-byte maps. The store type of
a raster map is primarily defined by the domain that the map is using. For value
maps this is determined by the value range and precision that you specify for the
output map during a calculation or operation. Usually, ILWIS will come up with
defaults, but you can adjust these values. Choosing a wide value range and a very
small precision results in a large data file on disk as more bytes are needed to store
each pixel value in the map, also the speed of display and the speed of calculations
may decrease.
For value maps that use 1 or 2 bytes per pixel, the map's histogram is automatically
calculated when you open the map and a histogram is not available yet. For value
maps that are stored using 4 or 8 bytes per pixel, you need to use the Histogram
operation to obtain the map's histogram.

Limitations
The maximum number of lines in a raster map is 2 billion. The maximum number
of columns is 32000 for bit, byte and 2-byte maps, 16000 for 4-byte maps and 8000
for 8-byte maps.

4.1.3 Polygon maps 
A polygon map is a data object used to store spatial geographic information that
consists of polygons, i.e. closed areas including the boundaries making up the
areas. The areas are either codified by IDs, class names or values; this is
determined by the domain of the map. The relation between polygons in a polygon
map and the position on earth is defined by the coordinate system that the map is
using.

Maps containing uniquely codified areas such as cadastral plots, or mapping units
such as geological formations, land use classes, or soil units, can all be stored as
polygon maps. Polygon maps are usually used as a stepping stone to raster maps.
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Polygon maps can be displayed in map windows, and edited with the polygon
editor.

A polygon map can be obtained:
n by importing an existing polygon map from ILWIS version 1.41,
n by creating a segment map and editing it with the segment editor (with or

without digitizer); then polygonize the segment map either in the segment
editor or with the Segments to Polygons operation,

n by performing ILWIS operations that return a polygon map as output, for
instance the Attribute map of polygon map operation.

Like in ILWIS 1.4, you first have to digitize segments and then polygonize these
segments to obtain a polygon map.

Contents of a polygon map and location of polygons
The contents of a polygon map are defined by the domain that the polygon map is
using. A polygon map may store for example:
n individual area features with or without attributes; each polygon has its own

mostly unique ID, for instance cadastral plot IDs; the map uses an ID domain,
n classes of area features with or without attributes; polygons may occur in several

places in the map, for instance land use classes or soil classes; the map uses a
class domain,

n area features representing measurable values; polygon values representing for
instance population densities or concentration levels of air pollution; the map
uses a value domain,

n true, false or undefined polygons; the map uses a Bool domain,
n output values (any domain) after performing an operation, e.g. IDs after the

Unique ID operation,
n attribute values (any domain) when an attribute map was created from an

attribute table with the Attribute map of polygon map operation.
For more information on domains, refer to Basic concepts : working with domains.

The spatial location of polygons in a polygon map is defined by the coordinate
system that the polygon map is using.

For maps using a class or ID domain, you can create an attribute table which stores
additional information on the classes or IDs in the map. Use the same class or ID
domain for the attribute table as you used for the map. Then, add the attribute
columns to the table. When you have for example a map with building blocks
(coded by IDs), you can add an attribute table with the predominant landuse per
building block and the number of residents per building block. Or when you have a
soil map (coded by classes), you can add an attribute table with pH, soil texture, etc.
for each soil unit. To create an attribute table, refer to How to create an attribute
table.

The colors in which a map appears on the screen are stored in a representation. For
maps that use a class domain or a value domain, you can create your own
representation. For value maps, there are also a number of system representations
available. For maps that use an ID or Bool domain, you have to specify colors each
time you display the map.
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Names of polygon maps
Any polygon map name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.

To create a polygon map
Open the File menu of the Main window and select the Create Segment Map
command, or double-click the New SegMap item in the Operation-list. In the
appearing Create Segment Map dialog box, enter a name and description for the
segment map, select or create a coordinate system, enter boundary values for the
map and select or create a domain. Optionally create a point map which will
contain the label points for your polygons. Digitize the polygon boundaries in the
segment editor; then polygonize your segments in the segment editor. For a more
detailed description, see How to create a polygon map.

To display a polygon map
The easiest way to display a polygon map is to double-click the map in the Catalog.
A Display Options dialog box appears, in which you can specify how the map
should be displayed in a new map window. You can also drag a polygon map from
the Catalog to an existing map window, in order to show that polygon map on top
of other information shown in the map window. For other methods, see How to
display maps and tables.

To edit a polygon map
You can edit a polygon map by clicking it with the right mouse button in the
Catalog and subsequently choose Edit from the context-sensitive menu. When a
polygon map is already displayed in a map window, you can also choose the Edit
Layer command from the Edit menu in the map window. For other methods, see
How to edit point, segment, polygon and raster maps.

In the Polygon editor, you can mainly edit the class names, IDs, or values of
polygons. You can use a digitizer but you can also use the mouse pointer.
Dependent polygon maps and read-only polygon maps cannot be edited.

Operations on polygon maps
The most frequently used operation on polygon maps is probably the Polygons to
Raster operation which rasterizes a polygon map. During this operation, you have
to select or create a georeference for the raster map to define the size of the pixels
in the raster map. Another operation on polygon maps is for instance Attribute map
of polygon map.

You can perform operations on a polygon map by selecting an operation from the
Operation-list or from the Operations menu (for other methods, see How to start
operations). Subsequently, fill out the appearing dialog box of that operation and
click the OK button; this generates an ILWIS expression on the command line.
Output objects that are obtained through an operation's dialog box are always
dependent. Advanced users can type the complete ILWIS expressions on the
command line of the Main window or create a script to execute a series of
expressions.
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For more information on dependent maps, see Basic concepts : dependent data
objects. For more information on operations, refer to ILWIS operations.

Technical information
A polygon map consists of an ASCII object definition file (.MPA) and a number of
binary data files (.PC#, .PD#, .PL#, .PS#, .TP#). The object definition file contains
further references to the domain and the coordinate system that the polygon map is
using; these are properties of a polygon map.

By viewing the properties of a polygon map, you can see whether the map is
dependent or not, which other objects the map is using, etc. For dependent maps,
you can also manage dependencies: break dependencies, make dependent maps up-
to-date, delete the dependent maps's data files, etc. For more information, see Basic
concepts : properties of objects.

A polygon map stores one or more polygons. A polygon is nothing more than a list
of XY-coordinate pairs (the polygon boundaries) which form the boundaries of a
polygon. The first and last coordinate pair of a boundary is called a node, so all
individual polygon boundaries are connected to each other by nodes. Each polygon
boundary is used both for the polygon on the left and right of this boundary; this is
called a topological structure. Polygons are identified by IDs, class names or values.

Coordinate pairs are stored as pairs of 2-byte fixed point reals. This means that a
paper map with a size of 3 by 3 meter can be stored with a resolution of 0.1
millimeter on paper. For all practical purposes, this should be enough. Paper maps
smaller than 3 by 3 meters can thus be stored with an even finer resolution. When
you create a map and specify the coordinate boundaries of the map, you should take
care that the boundaries do not exceed this size of 3 by 3 meter on paper.

Limitations
The maximum number of polygons in one polygon map is 32000. The maximum
number of polygon boundaries is 32000. The maximum number of coordinate pairs
in one polygon boundary is 1000 (taken care of by the system).

4.1.4 Segment maps
A segment map is a data object used to store spatial geographic information that
consists of lines, for example roads, rivers or contour lines. Segments are either
codified by IDs, class names or values (height map); this is determined by the
domain of the map. The relation between segments in a segment map and the
position on earth is defined by the coordinate system that the map is using.
Segment maps can be displayed in map windows, and edited with the segment
editor.

A segment map can be obtained:
n by importing an existing segment map from ILWIS version 1.41,
n by creating a new segment map and editing it with the segment editor with or

without using a digitizer, or
n by performing ILWIS operations that return a segment map as output, for

instance the Mask Segments operation.
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Contents of a segment map and location of segments
The contents of a segment map are defined by the domain that the segment map is
using. A segment map may store for example:
n individual line features: each segment is codified by its own ID for instance

when each pipe line or river section has its own unique ID; the map uses an ID
domain,

n classes of line features: segments may occur in several places in the map for
instance primary roads, secondary roads, etc.; the map uses a class domain,

n line features representing measurable values, for instance a contour map with
height information; the map uses a value domain,

n true, false or undefined segments; the map uses a Bool domain,
n output values (any domain) after performing an operation, e.g. IDs after the

Unique ID operation,
n attribute values (any domain) when an attribute map was created from an

attribute table with the Attribute map of segment map operation.
For more information on domains, refer to Basic concepts : working with domains.

The spatial location of segments in a segment map is defined by the coordinate
system that the segment map is using.

For maps using a class or ID domain, you can create an attribute table which stores
additional information on the classes or IDs in the map. Use the same class or ID
domain for the attribute table as you used for the map. Then, add the attribute
columns to the table. To create an attribute table, refer to How to create an attribute
table.

The colors in which a map appears on the screen are stored in a representation. For
maps that use a class domain or a value domain, you can create you own
representation. For value maps, there are also a number of system representations
available. For maps that use an ID or Bool domain, you have to specify colors each
time you display the map.

Names of segment maps
Any segment map name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.

To create a segment map
Open the File menu of the Main window and select the Create Segment Map
command, or double-click the New SegMap item in the Operation-list. In the
appearing Create Segment Map dialog box, enter a name and description for the
segment map, select or create a coordinate system, enter boundary values for the
map and select or create a domain. For other create methods, see How to create a
map.
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To display a segment map
The easiest way to display a segment map is to double-click the map in the Catalog.
A Display Options dialog box appears, in which you can specify how the map
should be displayed in a new map window. You can also drag a segment map from
the Catalog to an existing map window, in order to show that segment map on top
of other information shown in the map window. For other methods, see How to
display maps and tables.

To edit a segment map
You can edit a segment map by clicking it with the right mouse button in the
Catalog and subsequently choose Edit from the context-sensitive menu. When a
segment map is already displayed in a map window, you can also choose the Edit
Layer command from the Edit menu in the map window. For other methods, see
How to edit point, segment, polygon and raster maps.

Segment maps are edited with the Segment editor: you can insert new segments and
delete and undelete existing ones, edit the class names, IDs, or values of segments,
change the shape of segments, split and merge segments, and pack, check and
polygonize segments. You can use a digitizer but you can also use the mouse
pointer. Dependent segment maps and read-only segment maps cannot be edited.

Operations on segment maps
Frequently used operations on segment maps are for instance the Segments to
Polygons operation to polygonize a segment map and the Segments to Raster
operation which rasterizes a segment map. During the rasterize operation, you have
to select or create a georeference for the raster map to define the size of the pixels
in the raster map. Another operation on a segment map is for instance Contour
interpolation.
You can perform operations on a segment map by selecting an operation from the
Operation-list or from the Operations menu (for other methods, see How to start
operations). Subsequently, fill out the appearing dialog box of that operation and
click the OK button; this generates an ILWIS expression on the command line.
Output objects that are obtained through an operation's dialog box are always
dependent. Advanced users can type the complete ILWIS expressions on the
command line of the Main window or create a script to execute a series of
expressions.

For more information on dependent maps, see Basic concepts : dependent data
objects. For more information on operations, refer to ILWIS operations.

Technical information
A segment map consists of an ASCII object definition file (.MPS) and three binary
data files (.CD#, .SC#, .SG#). The object definition file contains further references
to the domain and the coordinate system that the segment map is using; these are
properties of a segment map.
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By viewing the properties of a segment map, you can see whether the map is
dependent or not, which other objects the map is using, etc. For dependent maps,
you can also manage dependencies: break dependencies, make dependent maps up-
to-date, delete the dependent maps's data files, etc. For more information, see Basic
concepts : properties of objects.

A segment map stores one or more segments. A segment is nothing more than a list
of XY-coordinate pairs. Each list of XY-coordinates represents a (part of a) linear
feature. Segments are identified by IDs, class names or values. Places where two or
more segments are connected are called nodes: a node is thus a common XY-
coordinate for two or more segments. Further, the beginning and end of a segment
are always nodes.

Coordinate pairs are stored as pairs of 2-byte fixed point reals. This means that a
paper map with a size of 3 by 3 meter can be stored with a resolution of 0.1
millimeter on paper. For all practical purposes, this should be enough. Paper maps
smaller than 3 by 3 meters can thus be stored with an even finer resolution. When
you create a map and specify the coordinate boundaries of the map, you should take
care that the boundaries do not exceed this size of 3 by 3 meter on paper.

Limitations
The maximum number of segments in one segment map is 32000. The maximum
number of coordinate pairs per segment is 1000 (taken care of by the system).

4.1.5 Point maps
A point map is a data object used to store spatial geographic information which
consists of points, for example water wells or sample points. Points are either
identified by IDs, class names or values; this is determined by the domain of the
map. The relation between points in a point map and the position on earth is
defined by the coordinate system that the map is using. Point maps can be displayed
in map windows, and edited with the point editor.

A point map is obtained:
n by importing an existing point map from ILWIS version 1.41,
n by creating a new point map and editing it with the point editor with or without

using a digitizer, or
n by performing ILWIS operations that return a point map as output, for instance

the Attribute map of point map operation or the Segments to Points operation.

Contents of a point map and location of points
The contents of a point map are defined by the domain that the point map is using.
A point map may store for example:
n individual point features: each point is codified by its own ID, for instance

individual sample points, individual bore holes, individual rainfall stations, etc.;
the map uses an ID domain,

n classes of point features: points may occur in several places in the map for
instance all water wells of a certain type; the map uses a class domain,
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n point features representing measurable values, for instance height information;
the map uses a value domain,

n true, false or undefined points; the map uses a Bool domain.
n output values (any domain) after performing an operation, e.g. IDs after the

Unique ID operation,
n attribute values (any domain) when an attribute map was created from an

attribute table with the Attribute map of point map operation.
For more information on domains, refer to Basic concepts : working with domains.

The spatial location of points in a point map is defined by the coordinate system
that the point map is using.

For maps using a class or ID domain, you can create an attribute table which stores
additional information on the classes or IDs in the map. Use the same class or ID
domain for the attribute table as you used for the map. Then, add the attribute
columns to the table. When you have for a example a point map with rainfall
stations, coded with IDs, you can add an attribute table with the rainfall figures per
month for each station. To create an attribute table, refer to How to create an
attribute table.

For point maps that use a class domain, you can create a representation. For maps
that use a value, ID or Bool domain, you have to specify the symbol set, symbol
size(s), colors, etc. each time you display the map. For point maps that use a value
domain, the size of symbols can be stretched according to the values of the points.

Names of point maps
Any point map name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.

To create a point map
Open the File menu of the Main window and select the Create Point Map
command, or double-click the New PntMap item in the Operation-list. In the
appearing Create Point Map dialog box, enter a name and description for the point
map, select or create a coordinate system, enter boundary values for the map and
select or create a domain. For other create methods, see How to create a map.

To display a point map
The easiest way to display a point map is to double-click the map in the Catalog. A
Display Options dialog box appears, in which you can specify how the map should
be displayed in a new map window. You can also drag a point map from the
Catalog to an existing map window, in order to show that point map on top of other
information shown in the map window. For other methods, see How to display
maps and tables.

Point maps can also be opened as tables: click the point map with the right mouse
button in the Catalog, and subsequently choose Open as Table from the context-
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sensitve menu. When you display a point map in a table window, you can edit the
XY-coordinates of the points and perform calculations with the XY-coordinates of
the points.

To edit a point map
You can edit a point map by clicking it with the right mouse button in the Catalog
and subsequently choose Edit from the context-sensitive menu. When a point map
is already displayed in a map window, you can also choose the Edit Layer
command from the Edit menu in the map window. For other methods, see How to
edit point, segment, polygon and raster maps.
Point maps are edited with the Point editor: you can insert new points and delete
existing ones, edit the class names, IDs, or values of points, and move points to a
new position. You can use a digitizer but you can also use the mouse pointer.
Dependent point maps and read-only point maps cannot be edited.

Operations on point maps
Examples of operations on point maps are for instance point interpolations: moving
average, trend surface, moving surface. The point map itself may use a value
domain but you can also use point maps with a class or ID domain that have an
attribute table which contains the values which you want to interpolate.

You can perform operations on a point map by selecting an operation from the
Operation-list or from the Operations menu (for other methods, see How to start
operations). Subsequently, fill out the appearing dialog box of that operation and
click the OK button; this generates an ILWIS expression on the command line.
Output objects that are obtained through an operation's dialog box are always
dependent. Advanced users can type the complete ILWIS expressions on the
command line of the Main window or create a script to execute a series of
expressions. For more information on dependent maps, see Basic concepts :
dependent data objects. For more information on operations, refer to ILWIS
operations.

Technical information
A point map consists of an ASCII object definition file (.MPP) and a binary data
file (.PN#). The object definition file contains further references to the domain and
the coordinate system that the point map is using; these are properties of a point
map.

By viewing the properties of a point map, you can see whether the map is
dependent or not, which other objects the map is using, etc. For dependent maps,
you can also manage dependencies: break dependencies, make dependent maps up-
to-date, delete the dependent maps's data files, etc. For more information, see Basic
concepts : properties of objects.

Each point is stored as a pair of XY-coordinates. The coordinates pairs are stored
as pairs of 8-byte floating point reals. Points are identified by a class name, ID or a
value.
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Limitations
The maximum number of points in a point map is 2 billion.

4.1.6 Map lists
A map list is a data object and stores the names of a set of raster maps, for example
of the multi-spectral bands of a satellite image that you want to classify. A map list
may also store the names of several raster maps of a time series which you can
display as a slide show. All raster maps in a map list must have the same the same
domain and georeference.

A map list is used:
n for sampling and image classification,
n for a principal components analysis or factor analysis,
n for the calculation of multiband statistics (variance-covariance matrix or

correlation matrix),
n to obtain some insight in the bands of a satellite image; create a map list of the

bands of a satellite image and show it as a slide show,
n to present temporal changes in maps; make a time-series by combining several

maps of the same theme but of for instance different years into a map list and
show the map list as a slide show.

Names of map lists
Any map list name must start with a character between A and Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.

To create a map list
Open the File menu in the Main window and select the Create Map List command,
or double-click the NewMapList item in the Operation-list, or start an operation

which requires a map list as input and click the create button  in the operation's
dialog box. In the appearing Create Map List dialog box, enter a name and
description for the map list, and select the raster maps that together should form the
map list.

To display a map list
A map list is simply a list of raster map names. You can display the individual
raster maps as usual for instance by double-clicking a raster map in the Catalog; the
map is displayed in a new map window. Further, you can display all maps of the
map list as a slide show in one map window; one map is displayed after the other.
To show a time series map list as a slide show, click a map list in the Catalog with
the right mouse button, and subsequently choose Open from the context-sensitive
menu or use the Operations menu in the Main window.
For more information on slide shows, see How to display a map list as a slide show
or Map window : advanced  functionality.
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To edit a map list
To edit a map list, double-click the map list in the Catalog or click the map list
with the right mouse button and subsequently choose Edit from the context-
sensitive menu. In the appearing Edit Map List dialog box you can change the
selection of raster maps that are included in the map list. See also How to edit a
map list.

Operations on map lists
Usually, you will create a map list during sampling to obtain a sample set with
which you can perform a supervised classification in a later stage. Sampling
however is an interactive process and not a genuine operation.
Operations on a map list return multivariate statistical information (a matrix) on
the values of the different raster maps in a map list. Only the Principal Components
and Factor Analysis operations result in an output map list.
You can start an operation on a map list by selecting an operation from the
Operation-list or from the Operations menu (for other methods, see How to start
operations). Subsequently, fill out the appearing dialog box of that operation and
click the OK button; this generates an ILWIS expression on the command line.
Output matrices and output raster maps that are obtained through an operation's
dialog box are always dependent; however output map lists are not dependent yet.
Advanced users can type the complete ILWIS expressions on the command line of
the Main window or create a script to execute a series of expressions.

Technical information
A map list consists only of an ASCII object definition file (.MPL). The object
definition file contains further references to raster maps that are included in the
map list.
By viewing the properties of a map list, you can see the size of the object and the
time it was last changed. In case you calculated a variance-covariance matrix or a
correlation matrix, the properties dialog box contains an extra button Additional
Info which shows you the Optimum Index Factor (OIF) of the maps in the map list.
For more information, see How to calculate the OIF of a map list.

Limitations
In principle, the maximum number of raster maps that can be included in a map list
is 5440. In practice however limitations will occur by memory and available disk
space. For operations that result in a matrix, a map list cannot contain more than
80 raster maps.

4.1.7 Tables
A table is a data object storing columns. A table usually contains tabular
information which refers existing geographic information stored in maps. The table
then contains extra information on the mapping units, polygons, segments or points
in your maps, for instance cadastral information, soil information, etc. Such a table
is called an attribute table. Raster, polygon, segment and point maps with a class or
ID domain can have an attribute table. The domain of an attribute table should
always be the same as the domain of the map to which the table relates.
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Further, tables may store columns that contain the answers of an operation on a
map, for instance an output cross table or output tables of a statistical operation.
The domain of a table generated by an operation may be created by the operation
itself or the table may use domain None. Tables that use domain None cannot be
linked to a map.

Tables can be displayed and edited in a table window. A table window also offers
you the possibility to display graphs. You can calculate with the columns in a table
by typing a Table Calculation formula on the command line of a table window. For
more complicated calculations, you can use the Columns menu in the table window.

Contents and structure of a table
A table consists of records and columns. The smallest unit in a table is called a
field.

Record names in a table are defined by the domain of the table:
n In a table window which displays a table in Table View, record names appear

on (gray) record buttons that are arranged along the left side of the table.
n Attribute tables use the same class or ID domain as the map to which they refer.

When, for instance, you have an attribute table for a soil map (both using class
domain Soils), then the classes of that domain appear as units in the map and as
records in the attribute table. Or, when you have an attribute table for a map
with cadastral plots (both using ID domain City), then the IDs of that domain
appear as units in the map and as records in the table. Attributes on the classes
or identifiers in a map are stored in attribute columns which have their own
domain (class, ID, or value), see below.

n Tables cannot have a value domain because conceptually spoken you cannot
have extra information on value maps; extra tabular information on maps that
represent interpolated height values, measured rainfall figures, or the calculated
total number of people per building block, etc. does not exist.

n A table that uses domain None cannot be linked to a map. Records in a table
that uses domain None are simply identified by record numbers.

Columns in a table have a name, a description, and each column uses a domain:
n In a table which displays a table in Table View, column names appear on (gray)

column buttons that are arranged along the top of the table, just below the
command line and the menu bar.

n The domain of each column depends on the kind of data you want to store in
that column: select or create for example a value domain if you want store pH
values for your soil classes or the String domain if you want to store a text-
description for each soil class.

n You can add as many columns to a table as you like. Also by performing
calculations, you can obtain new columns.

n When a column uses a value domain, the column also has a value range and a
precision.

n Optionally, the domain of a column may have a representation, which is handy
in case you wish to display a map that has an attribute table by one of the
attributes, i.e. using the Attribute check box in the Display Options dialog box
of that map.
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n If a table has a certain domain that also exists in another table, or if a column of
a table has a certain domain that also exists in another table, then you can join
columns of the other table into the current table.

For more information on columns, see ILWIS objects : columns.

Names of tables
Any table name must start with a character from A to Z. For the other characters in
an object name, you are allowed to use: characters A through Z, numbers 0 through
9, and underscores. Object names cannot exceed 8 characters.

To create a table
The easiest way to create an attribute table is to open the Properties dialog box of a
map, and then select the Attribute check box in the dialog box. Subsequently, create
the table by clicking the little create button that appears next to the Attribute drop-
down list box. The Create Table dialog box appears in which you can specify a
name and description for the table. The domain of the table is already filled out and
is the same domain that is used by the map. For other methods, see How to create a
table. A table with domain None cannot be linked to a map.

To display and edit a table
The easiest way to open and edit existing tables is to double-click a table in the
Catalog; the table is shown in a table window. For other methods of opening tables,
see How to display maps and tables.

In a table window, a table can be displayed and edited in Table View and in Record
View: Table View gives you an overview of the whole table and Record View
displays the contents of a table record by record. For more information, see How to
edit a table. It is not possible to edit the fields of dependent and read-only columns
or the fields of table-owned columns in dependent tables. Table information can
also be shown as graphs.

When an attribute table is linked to a map or to its domain, and the map is
displayed in a map window, you can also double-click in the map to edit the
attributes in the attribute table. For more information on the double-click action,
see Map window : advanced functionality.

Operations on tables
Calculations within tables are usually performed on columns. You can calculate
with columns by typing a Table Calculation formula on the command line of a table
window. When the definition symbol = is used in a calculation, the output column
is dependent. For more complicated column operations such as aggregations,
calculating cumulative values, joins, and least square fit calculations, you can use
the Columns menu. For more information on columns, see ILWIS objects :
columns.

When a table is the result of an operation such as the Cross operation or the
statistical operations, the table itself is dependent and the columns created by the
operation are table-owned. For more information on dependent objects, see Basic
concepts : dependent data objects.
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With the Transpose Table operation, all records become columns and all columns
become records.

Technical information
A table consists of an ASCII object definition file (.TBT) and a binary data file
(.TB#). The object definition file of a table stores the table name, table description,
whether the table is dependent or not, the number of columns in the table, column
names, column descriptions, and for dependent columns the column definitions,
etc. Further, the object definition file contains references to the table's domain, the
table's data file, and the domains that are used by the individual columns. The .TB#
file stores the data of the columns.

By viewing the properties of a table, you can see which domain the table is using
and whether the table is dependent or not. For dependent tables, you can manage
dependencies: break dependencies, make dependent tables up-to-date, delete the
dependent table's data file, etc. For more information, see Basic concepts :
properties of objects.

Limitations
In principle, the maximum number of columns in a table is 32000 and the
maximum number of records in a table is 2 billion. In practice however, limitations
will occur by memory and available disk space.

4.1.8 Columns
A column is a data objects that is part of a table; a column can be used to store
attributes, results of calculations, results of operations, etc. Fields in a column may
contain class names, IDs, values, X- and Y-coordinates, colors, text, etc.; this is
determined by the domain of the column.

Columns are displayed and edited in a table window. You can calculate with
columns by typing a Table Calculation formula on the command line of a table
window. For more complicated calculations, you can use the Columns menu in the
table window.

Contents of columns
The contents of a column is defined by the domain that the column is using. For
each new column that you add to a table, you have to select (or create) a domain
which fits the kind of data you want to store in that column, similar to the selection
or creation of a domain when you make a new map. In a Soil table for example, you
can select the system String domain for a column Description that should store
descriptions of soil types, and you can select the system Value domain or create
your own value domain pH for a column pH that should store pH values.

When calculating with columns, it is normally enough to select system domain
Value or one of the other system domains. You only have to create a new value
domain, if the column will contain values that have a special 'standardized'
meaning.
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A column may store for example:
n names of districts, provinces, regions, etc. for instance in a table containing all

building blocks of a city, the district of the city in which each building block
occurs (for aggregations); the column uses an ID domain,

n class names like suitable, moderately suitable, not suitable or slope classes that
apply for the records; the column uses a class domain,

n rainfall values, pH values for boreholes, number of people per building block,
etc.; the column uses a value domain,

n free text for instance to describe the records of the table; the column uses the
String domain,

n true or false values; the column uses the Bit domain,
n true, false or undefined values; the column uses a Bool domain,
n percentage values; the column can use the Perc domain,
n colors; the column uses the Color domain,
n X- or Y-coordinates; the column uses a value domain,
n output values after a table calculation (any domain),
n output values (any domain) in tables that are the result of an operation, e.g.

values and percentages after a Histogram operation, classes of two input maps
and values after a Cross operation on two class maps, distances and
probabilities (values) after the Pattern Analysis operation, directions, lengths
and number of segments (all values) after the Segment directions operation, etc.

For more information on domains, refer to Basic concepts : working with domains.

The domain of a column may have a representation. This may be useful if the table
is an attribute table; when displaying a map, you can directly display the map by an
attribute column, thus without physically creating an attribute map. To display a
map by attribute, select the Attribute check box in the Display Options dialog box
which appears when opening the map. For more information, see How to display a
map by one of its attributes.

Types of columns
Source columns: Normal editable columns.
Dependent columns: Columns that store the result of a calculation:

ColumnCalculate, ColumnJoin, ColumnAggregate,
ColumnCumulative, ColumnLeastSquares.

Table-owned columns: Columns that are part of a dependent table and store the
results of an operation e.g. output columns of the
Histogram and Cross operation, and other statistical
operations. Also objects that internally use a table for
storage (point maps; class, ID and picture domains; class
representations; georeference tiepoints) and which thus can
be opened as a table have table-owned columns.

To protect the results of calculations or operations, fields of dependent columns and
table-owned columns in a dependent table are not editable unless you break the
dependency links of the dependent column or unless you break the dependency
links of the dependent table.
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Names of column
Any column name must start with a character from A to Z. For the other characters
in an object name, you are allowed to use: characters A through Z, numbers 0
through 9, and underscores. Contrary to names of other objects, column names can
be as long as you like.

To create a column
An easy way to add a new column to a table is to open the Columns menu and
select the Add Column command. In the appearing Add Column dialog box, enter
a name and description for the column and select or create a domain. For other
create methods, see How to add a column to a table. Columns added in this way are
always source columns, i.e. editable columns. Even if you use such a column later
on as the output column of a calculation, the column remains a source column.
You can also directly add a new column to a table by typing a Table Calculation
formula on the command line of the table window which contains a new column
name, or by using the Columns menu to join columns from another table, to
perform aggregations or to calculate cumulative sums of columns or perform a least
squares fit.

New columns created by typing a TabCalc formula on the command line in which
you use an equal symbol (=) are dependent columns. Columns that contain the
result of a join, aggregation, cumulative sum or least squares fit obtained through a
dialog box are also dependent columns. When you use the assignment symbol (:=)
in a TabCalc formula, the new column is an editable source column.

You may add as many columns to a table as you like. To change the order and
width of columns or to sort the records of a table, see Table window : functionality.

To edit fields of a column
When a table is displayed in a table window, you can edit the fields of source
columns directly both when a table is displayed in Table View or in Record View.
First select a field in the table, then type a new value of ID when the column uses a
value or identifier domain, or open the drop-down list box of the field and then
select a class name from the drop-down list box when the column uses a class
domain. For more information, see How to edit a table.

Fileds in dependent columns are not editable unless you break the dependency link
of the column; you can do this in the Properties dialog box of the column. Further,
fields in table-owned columns in dependent tables are not editable unless you break
the dependency links of the table; you can do this in the Properties dialog box of the
table. However, the fields in table-owned columns in objects that are internally
stored as a table and that can be opened as a table (e.g. point maps and class
representations), can usually be edited.

Operations on columns
Mostly, you will calculate with columns using the operators and functions that are
available in Table Calculation. You can type your table calculation formulae on the
command line of a table window.
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When you use the definition symbol = in a TabCalc formula that contains a new
column name, a dependent column is created. For more information, see also Basic
concepts : dependent data objects and Table Calculation.
When you use the assignment symbol := in a Table Calculation formula, a source
column is created.

Further, you can use the Columns menu to join, aggregate, calculate a cumulative
sum or a least squares fit. Subsequently, fill out the appearing dialog box of that
column operation and click the OK button; this generates an expression on the
command line of the table window. Output columns that are obtained through an
operation's dialog box are always dependent. Advanced users can type these
complete expressions on the command line of a table window, or ILWIS
expressions on the command line of the Main window or create a script to execute a
series of expressions. For more information, refer to Appendices : ILWIS
expressions.

Lastly, the columns of a dependent table in which the results are stored of an
operation such as the Histogram operation or statistical operations on maps are
table-owned columns. For more information, refer to the Histogram operation, etc.

When calculating with columns and you want to store values in a column, you can
usually select the system domain Value, and specify value range and precision, see
below.

Technical information
Columns have no object definition file of their own. All necessary information to
display, edit and calculate with columns is stored in the object definition file of the
table (.TBT) to which the column belongs. Column data is stored in the binary file
of the table (.TB#).

Each column has a domain, which is a property of a column. By viewing the
properties of a column, you can see whether the column is dependent or not, which
domain the column is using and in case of dependent columns which other columns
the column is using, etc. For dependent columns, you can also manage
dependencies: break dependencies, make dependent columns up-to-date, delete a
dependent column's data file, etc. For more information, see Basic concepts :
properties of objects and How to view the properties of objects.

Columns are stored as bit, byte, 2-byte, 4-byte or 8-byte columns. The store type of
a column is primarily defined by the domain that the column is using. For value
columns this is determined by the value range and precision that you specify for the
output column during a calculation or operation. Usually, ILWIS will come up with
defaults, but you can adjust these values. Choosing a wide value range and a very
small precision results in a large data file on disk as more bytes are needed to store
the column values.
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Limitations
In principle, the maximum number of columns in a table is 32000 and the
maximum number of records in a table is 2 billion. In practice however, limitations
will occur by memory and available disk space.

4.1.9 Link between maps and tables
The relational link between point, segment, polygon or raster maps and an attribute
table, is provided by the domain. The domain should be of the ID or Class type. The
domain should be used both by the map(s) and the table. The table contains
additional columns with the attributes.

An attribute table can also be linked to a domain (domain Class or ID). Then all
maps using that domain automatically use the attribute table which has the same
domain.

It is the class names in a domain Class and the IDs in a domain Identifier that
provide the relational link between the elements in a raster, polygon, segment or
point map and the records in an attribute table.

Whether a map or a domain has an attribute table can be seen by viewing the
properties of the map or the domain.

4.2 Service objects
Service objects are used by data objects; they contain accessories required by data
objects besides the data itself. Service objects define for example the valid type of
values for a data object (ID, Classes, Values), the colors assigned to the data, and,
coordinate information for the data object.

Service objects are:
domain
representation
georeference
coordinate system

Service objects can be selected to serve one or more data objects, created, changed,
etc. through the properties dialog box of a data object or another service object. For
more information, see Appendices : Relations between ILWIS objects.

Object names should start with a character from A to Z. For the other characters in
an object name, you are allowed to use: characters A through Z, numbers 0 through
9, and underscores. Object names cannot exceed 8 characters.

F 1. To show service objects in the Catalog, use the Catalog command on the 
Options menu in the Main window. See also How to customize the Catalog;

F 2. It is advised to use the same service objects for several data objects:
n if you have several thematic maps with the same kind of class names (not

every class has to exist in each map), you should use the same domain for all
maps,
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n if you have several raster maps of the same study area, you should use the
same georeference for all maps.

F 3. To copy or delete ILWIS objects, you MUST use the Copy Object or Delete 
Object commands on the Edit menu of the Main window, or choose the Copy or 
Delete commands on the context-sensitive menu, when clicking with the right 
mouse button on an object in the Catalog. It is strongly discouraged to copy, 
delete or rename files in DOS or in the File Manager.

4.2.1 Domains
A domain defines, i.e. stores, the information that can be available in a map, a
column, etc. A domain consists of a set of class names or IDs, a range of values,
colors, etc. All elements in a map or column must use one of the classes, IDs, or
values of the domain that is used by the map or column; if not, these elements will
appear as undefined.

General use of domains
All maps and all columns need a domain:
n When a map contains for instance information on land use types, the map

should use a class domain. The class domain contains the complete list of all
land use classes that should be available for all your land use maps.

n When a map contains for instance information on height values, the map should
use a value domain in which your height values fit.

n When a column contains calculated values, the column should use a value
domain in which your  calculated values fit.

A table needs a domain when the records in the table contain further information
on units in a map. To establish a relation between a map and a table, the table
needs to have the same domain as that map. Such tables are called attribute tables.
Further, for a join between tables and columns, the tables or one of their columns
should both use the same domain.
A table has domain None when the records in the table contain other 'stand-alone'
information, for instance the results of a statistical operation.

A domain is a service object; it is the user-defined collection of IDs, class names, or
values that can be used in a certain data object. All ILWIS data objects (maps,
tables and columns) have a domain. One domain can be used for several data
objects. Domains provide the relational link between maps, tables and columns. For
an introduction on domains, refer to Basic concepts : before creating ILWIS maps
and tables and Basic concepts : domains.

Domain types
The four main types of domains are:
ID used for data objects which contain unique identifiers (e.g. plot 1024,

plot 1025).
Class used for data objects which contain classes (e.g. soil units: clay, sandy

loam).
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Value used for data object which contain measured, calculated or interpolated
values (e.g. height, concentration).

Image for satellite images containing values between 0 and 255.

Other domain types are
Bit system domain Bit is available for raster maps and columns that have

to store values 0 and 1.
Bool system domain Bool and system domain Yes/No are available for point,

segment , polygon and raster maps and columns that have to store
True, False or undefined values.

Picture for raster maps which contain merely colors (Red, Green, Blue); the
pixels have no meaning e.g. color composites.

Color for raster maps that are stored in 24-bit colors.
Group used to classify or slice a value map; a domain group contains upper

value boundaries and output class names.
String system domain String is available for columns that contain text.
None system domain None is available for tables in which the records do not

store information on a map.
Binary system domain Binary is for internal use only.

Names of domains
Any domain name must start with a character from A to Z. For the other characters
in an object name, you are allowed to use: characters A through Z, numbers 0
through 9, and underscores. Object names cannot exceed 8 characters.

F To show domains in the Catalog, refer to How to customize the Catalog.

To create a domain
When creating a new map, table or column, you have to select an existing domain
or create a new domain for the object. When you do not have a suitable domain yet,

you can usually click the create button  next to a domain list box in a dialog box.
Of course you can also use the Create commands on a File menu, or double-click
the New Domain item in the Operation-list. For more information, see How to
create a domain.

When calculating with value maps or columns or performing operations, you can
generally accept the default system domain Value for the output map or column and
adjust the value range and precision for the output map or column if necessary. You
only have to create a user-defined value domain for a calculated map when the
output values in the map have a specific meaning for which you have or want to
create a meaningful representation value.
n When creating a new class or group domain, a representation class is

automatically created with the same name as the class domain. You can open
and edit this representation with the Representation Class editor.
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n When creating a new value domain, a representation is not automatically
created. You can always show a map with any value domain with existing
representation graduals (in percentages). The easiest way to create a
representation value for a map with a user-defined value domain is to click the

create button  in the Display Options dialog box of the map. You can insert
boundary values and assign colors to these boundaries and in between the
boundaries in the Representation Value/Gradual editor.

To view and edit a domain
To view and edit a class domain, an ID domain and a value domain, you can for
instance double-click them in the Catalog. Class and ID domains are shown and
can be edited in the Domain Class/ID editor; a value domain can be viewed in the
Edit Domain Value dialog box. It is usually not necessary to edit a value domain.
When a map of domain type Class or ID is displayed in a map window, you can
also open the Edit menu in the map window and choose Domain. For more
information, see How to edit a domain.

Advanced users may wish to open a domain class, ID or picture as as a table. For
more information, see How to open objects as a table. System domains and read
only domains cannot be edited. Information on these domains can be found in their
properties dialog box.

Domains and representations
A domain may use a representation which defines the colors, line widths etc. with
which a map can be displayed.
n A class domain, a group domain and a picture domain have an editable

representation class.
n When a map uses the system Value domain: you can create your own

representation gradual (in percentages), or use one of the existing system
representations gradual.

n When a map uses the Image domain or any other value domain: you can create
your own representation value (in values), or use one of the existing system
representations gradual.

For more information on representations and the relations to domains, refer to
ILWIS objects : representations.

F When you want to be sure that you cannot change the representation of a domain,
you can make the domain read only in the Properties dialog box of the domain.

Choosing a value domain for output maps and columns
When calculating with value maps and value columns, you can usually accept the
default system domain Value and you can adjust the value range and precision for
the output map if necessary. When you adjust for instance the value range for an
output map or column to minimum 5 and maximum 500 and a precision of 0.001;
the output map or column will only store values in between 5 and 500 with 3
decimals; in case the calculation or operation results in values smaller than 5 and
larger than 500, these will appear as undefineds (a question mark).
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You only need to create a user-defined value domain (for instance Height, pH,
Yields, or concentration values):

n if the output values have a specific 'standardized' meaning that you want to
document and

n if you have, or want to create, a specific representation value for these values
where colors or ranges of colors are linked to the values.

Technical information
A domain consists of an ASCII object definition file (.DOM); in case of a domain
class, ID or group a binary data file (.DM#) is also available. In case of a domain
class or picture, the object definition file stores further references to a
representation class; in case of a domain value, the object definition file stores a
reference to a representation value or gradual.

By viewing the properties of a domain, you can see for instance the type of the
domain and select a representation for the domain. Furthermore, you can also see
by which maps and and in which tables this domain is used. Optionally, you can
create a new attribute table for a class or ID domain or link an existing attribute
table to a class or ID domain.

For more information on the key role of domains within ILWIS, refer to
Appendices : Relations between ILWIS objects.

Available system domains
The following value domains are available in your ILWIS\SYSTEM directory:
n system domain Value
n system domain Image
n system domain NOAA
n system domain Radar
n system domain Distance
n system domain Count
n system domain Min1to1
n system domain Perc
n system domain Bit
n system domain Bool
n system domain YesNo
n system domain String
n system domain Color
n system domain ColorCmp
n system domain None
n system domain Binary
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Limitations
ID domains Maximum number of IDs in a domain ID: 2 billion. The

domain ID editor however has a limitation of 5440 items. ID
names can have any length; the width to display IDs is set in
the properties of the domain.

Class/Group domains Maximum number of classes in a class domain is 255 as a
representation class cannot contain more than 256 colors.
Class names can have any length; the width to display class
names is set in the properties of the domain.

Value domains When you use a value domain, values can either be stored as
fixed point reals using 1, 2, or 4 bytes storage per pixel
(max. 4 billion different values) or as floating point reals
according to the 8 byte real IEEE standard.

Picture domains Maximum number of colors is 256.

4.2.2 Representation
A representation defines the manner in which classes of a domain Class map, or
values in a domain Value or domain Image map should be shown and colored. For
raster maps, a representation contains merely colors; for segment, polygon and
point maps there are also possibilities to define for instance: line widths, patterns,
and symbols. Furthermore, a representation is needed for raster maps with a
domain Picture. A representation is a service object for a domain.

Maps with a Bool, the Bit or an ID domain do not have stored representations on
disk. For maps with a Bool or the Bit domain, you can select colors in the Display
Options dialog box of the map each time you display the map. Maps with an ID
domain can be shown in 7, 15, or 31 colors to inpect the map itself, however in
most cases you will display an ID map by one of its attributes from its attribute
table; the options are available in the Display Options dialog box.

Furthermore, special options for point symbols available in the Display Options
dialog box of a point map. Raster maps with the Color domain store colors in each
pixel, so no representation is needed.

Types of representations
There are three types of representations:
n representation class: for the classes in a class domain, the groups a group

domain, or the items in a picture domain;
n representation gradual: for ranges of values (as percentages) in any value

domain;
n representation value: for ranges of values in the Image domain or a value

domain, except system domain Value.

General use of representations
n All maps which use the same class domain (e.g. Landuse), use by default the

same representation class, and are thus by default displayed in the same colors;
you can also create or select another representation class which fits the classes
in the domain;
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n All maps which use the same value domain use by default the same
representation value and are thus displayed in the same colors; you can also
create or select another representation value which has this domain. You can
also create or select a representation gradual.

n For maps which use the system domain Value, you can only select a
representation gradual; you can also create your own representation gradual;

Names of representations
Any representation name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.

F To show representations in the Catalog, refer to Help topic: How to customize the
Catalog.

F To view which representation is used by a domain, check the properties of the
domain.

To create a representation
When creating a new class or group domain, a representation class is automatically
created with default colors; these can of course be edited. The easiest way to create
another representation class for a map with a class, group or picture domain, is to

click the create button  in the Display Options dialog box of the map. Then a new
representation class is created for the domain that is used by the map. The
Representation Class editor is opened. In the Representation Class editor, you can
edit the colors, etc. of each class. You can double-click a class in the editor and
select or create a color, etc.

When creating a new value domain, a representation value is not automatically
created. You can always show a map with any value domain with existing
representation graduals. The easiest way to create a representation value for a map
with a  value domain (except the system Value domain) is to click the create button

 in the Display Options dialog box of the map. Then a new representation value
is created for the domain that is used by the map. The Representation
Value/Gradual editor is opened.

In the Representation Value/Gradual editor, you can insert limits, i.e. boundary
values for a representation value, you can choose or create a color for each limit,
and you can indicate whether to stretch between the limits or to use the color of the
upper of lower boundary.

When you click the create button  in the Display Options dialog box of a map
which uses the system domain Value, a new representation gradual is created with
default colors. The Representation Value/Gradual editor is opened.
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In the Representation Value/Gradual editor, you can insert limits, i.e. boundary
percentages for a representation gradual, you can choose or create a color for each
limit, and you can indicate whether to stretch between the limits or to use the color
of the upper of lower boundary.

Furthermore, you can create representations through the File menu of the Main
window, the New Repr item in the Operation-list, or in the Properties dialog box of
a domain. For more information, see How to create a representation.

To view and edit a representation
To edit an existing representation, you can for instance double-click a
representation in the Catalog. When a map is displayed in a map window, you can
also open the Edit menu in the map window and choose Representation. Depending
on the type of representation you selected, the Representation Class editor or the
Representation Value/Gradual editor is opened. For more information, see How to
edit a representation.

Advanced users may wish to open a representation class as a table. For more
information, see How to open objects as a table. System representations and read
only representations cannot be edited.

Technical information
A representation consists of an ASCII object definition file (.RPR); in case of a
representation class also a binary data file (.RP#) is available. The object definition
file has no further references to other objects.

By viewing the properties of a representation, you can see for instance the type of
the representation and find out to which domain the representation is linked. A
representation is a property of a domain.

A representation class stores, for each class in the domain:
n a color (raster form);
n a color and a pattern (polygon form);
n a color and a line width (segment form);
n symbol type, size, pen width, color and fill color (point form).

A representation gradual stores:
n limits, i.e. boundary values as percentages of the values in the domain,
n a color for each limit,
n for each range of percentages in between two limits, whether to stretch colors or

to use the color of the upper of lower boundary (slice), and
n when you stretch the colors in between two limits: the number of steps to be

used for stretching.
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A representation value stores:
n limits, i.e. boundary values as real values of the domain,
n a color for each limit,
n for each range of values in between two limits, whether to stretch colors or to

use the color of the upper of lower boundary (slice), and
n when you stretch the colors in between two limits: the number of steps to be

used for stretching.

System representations
The following system representations are representations gradual:
Blue From black to blue in 16 stretch steps.
Clrstp6 Six times from black to a color (6 colors between blue to red), each

time in 8 stretch steps.
Clrstp8 Eight times from black to a color (8 colors between blue to red),

each time in 8 stretch steps.
Clrstp10 Ten times from black to a color (10 colors between blue to red),

each time in 8 stretch steps.
Clrstp12 Twelve times from black to a color (12 colors between blue to red),

each time in 8 stretch steps.
Cyan From black to cyan in 16 stretch steps.
FineGray From black to white in 60 stretch steps.
Gray From black to white in 30 stretch steps.
Green From black to green in 16 stretch steps.
Inverse From white to black in 30 stretch steps.
Magenta From black to magenta in 16 stretch steps.
Pseudo From blue to green to red in 6 x 9 stretch steps.
Red From black to red in 16 stretch steps.
Yellow From black to yellow in 16 stretch steps.

There is one system representation class avaible:
ColorCmp Designed for output raster maps of the Color Composite operation

created with the Standard option; 216 colors.

4.2.3 Georeference
A georeference defines the relation between rows and columns in a raster map and
XY-coordinates. The location of pixels in a raster map is thus defined by a
georeference. It is advised that raster maps of the same area use the same
georeference. A georeference uses a coordinate system which may contain
projection information. Polygon, segment and point maps merely use a coordinate
system. A georeference is a service object, usually for several raster maps.
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Georeference types
There are three main types of georeferences:
n georeference corners: for North-oriented rasterized vector data or resampled

raster data;
n georeference tiepoints: for satellite images, scanned photographs, scanned

maps, etc.;
n georeference 3D: to create three dimensional views of maps.

Georeference None is available for raster maps that do not have coordinates.
Other types of georeferences can be obtained when performing an operation on
raster maps:
n georeference factor: created by the Aggregate map and the Densify operation;
n georeference mirrorrotate: created by the MirrorRotate operation;
n georeference submap: created by the Sub-map of raster map and the Glue raster

maps operation.

General use of georeferences
When a raster map has a georeference, you can:
n inspect coordinates at the position of the mouse pointer in a map window, at the

status line;
n retrieve information at the position of the mouse pointer in a map window from

other maps, i.e. functionality of the pixel information window;
n overlay vector data on raster maps;
n rasterize vector data to raster maps;
n resample raster data which uses a particular georeference to another

georeference;
n check if raster maps fit on top of each other (requirement for MapCalc and

Cross);
n inspect the pixel size of raster maps in meters.

A map window also uses a georeference. When the map window displays a raster
map, this is the georeference of the raster map. When a map window only displays
vector data, an internal georeference is used that is created from the coordinate
system and coordinate boundaries of the vector maps.

Names of georeferences
Any georeference name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.

F To show georeferences in the Catalog, refer to How to customize the Catalog.
F To view which georeference is used by a raster map, check the properties of the

raster map.
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To create a georeference
To rasterize vector maps, select one of the Rasterize operations on the Operations
menu of the Main window, in the Rasterize dialog box you can directly create a

new georeference corners by clicking the create button . The Create Georeference
Corners dialog box appears in which you can specify the pixel size and the
boundaries of the map. When rasterizing maps of the same area, it is usually
sufficient to only once create a georeference corners; for the other maps to be
rasterized, select this same georeference.

To add tiepoints to an image, i.e. create a georeference tiepoints: display in a map
window an image (for instance a color composite) on which you can clearly
distinguish the tiepoints, also called control points, and select from the File menu
in the map window, Create Georeference. Have an analog paper map at hand to
find the XY-coordinate for each row-column number at which you want to position
a tiepoint. For more information, see Georeference tiepoints editor : functionality.

To create a three-dimensional view of your study area, select the Display 3D
operation from the Operations menu in the Main window, a Digital Elevation
Model (DEM) of your area is required. For more information, see Georeference 3D
editor: functionality.

Of course, you can also use the Create Georeference command on the File menu in
the Main window, or double-click the NewGeoref item in the Operation-list.  For
more information, see How to create a georeference, How to add coordinates to an
image, or How to display a DEM.

To view or edit a georeference
You can view and edit a georeference corners, a georeference tiepoints and a
georeference 3D. The easiest way to edit such a georeference is to double-click such
a georeference in the Catalog. When a raster map which has a georeference is
displayed in a map window, you can also open the Edit menu and choose
Georeference. Depending on the type of georeference you open (or which is used by
the raster map in the map window) the Georeference corners dialog box appears,
the Georeference tiepoints is opened or the Georeference 3D editor is opened. For
more information, see How to edit a georeference.

A georeference factor, georeference mirrorrotate or a georeference submap cannot
be edited. Information on these georeferences can be found in their properties
dialog box.

Advanced users may wish to open a georeference tiepoints as a table. For more
information, see How to open objects as a table.

Technical information
A georeference constists of an ASCII object definition file (.GRF); in case of a
georeference tiepoints, a binary data file (.GR#) is also available. The object
definition file contains further references to the coordinate system that is used by
the georeference and in case of a georeference tiepoints, the background map is also
mentioned; these are properties of a georeference.
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By viewing the properties of a georeference, you can see for instance the type of the
goereference and find out which raster maps are using this georeference.
The system georeference None is available for raster maps that do not have
coordinates.

Georeference corners: Stores minimum and maximum XY-coordinates, and
whether these refer to the corners of the corner pixels or to the centers of the corner
pixels.
Col = a1X + b1

Row = a2Y + b2

Georeference tiepoints: Stores a set of tiepoints in RowCol and XY-coordinates and
a transformation method. Parameters are found by a least squares method.
Available transformation methods and their formulas are:

Conformal: minimum of two tiepoints required;
Col = aX + bY + c1

Row = bX - aY + c2

Affine: recommended for satellite images; minimum of three tiepoints required;
Col = a11X + a12Y + b1

Row = a12X + a22Y + b2

Second order bilinear: minimum of 4 tiepoints required;
Col = a1 + b1X + c1Y + d1XY
Row = a2 + b2X + c2Y + d2XY

Full second order: minimum of 6 tiepoints required;
Col = a1 + b1X + c1Y + d1XY + e1X² + f1Y²
Row = a2 + b2X + c2Y + d2XY + e2X² + f2Y²

Third order: minimum of 10 tiepoints required;
Col = a1 + b1X + c1Y + d1XY + e1X² + f1Y² + g1X³ + h1X²Y + i1XY² + j1Y³
Row = a2 + b2X + c2Y + d2XY + e2X² + f2Y² + g2X³ + h2X²Y + i2XY² + j2Y³

Projective: recommended for near vertical aerial photographs and oblique
photographs; minimum of 4 tiepoints required;
Col = (aX + bY + c) / (gX + hY + 1)
Row = (dX + eY + f) / (gX + hY + 1)

Georeference 3D: Stores a number of 3D view parameters: view point, location
height, scale height, horizontal and vertical rotation, distance, view angle.

Georeference factor: Stores a factor of the pixel size of another raster map and
horizontal and vertical offset of another raster map.

Georeference mirrorrotate: Stores whether another georeference is mirrored
horizontally, vertically, diagonally or is transposed, or rotated 90, 180, or 270°.

Georeference submap: Stores offset and size related to another georeference.
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4.2.4 Coordinate system
A coordinate system contains information on the kind of coordinates you are using
in your maps; you may for instance use user-defined coordinates, coordinates
defined by a national standard or coordinates of a certain UTM zone. A coordinate
system defines the possible minimum and maximum X's and Y's that can be used in
your maps.

To be able to convert one coordinate system into another, a projection with
parameters needs to be attached to both coordinate systems. If a projection is added
to a coordinate system, the maps using this coordinate system can be displayed with
a graticule.

Point, segment and polygon maps always have a coordinate system. Raster maps
have a georeference which uses a coordinate system. A coordinate system is a
service object for point, segment and polygon maps, and for georeferences of raster
maps.

General use of coordinate systems
n For general analysis purposes, it is advised to use one coordinate system for all

your maps. This coordinate system should be wide enough to cover all X and Y
coordinates that should be stored in your maps.

n When you receive data in different projections (coordinate systems), it is
advised to use the Resample operation to resample pixels of a raster map the
current georeference into one other georeference (coordinate system), or to use
the Transform operations to transform vector data from the current coordinate
system into one other coordinate system.

n For presentation purposes of small scale maps (countries, continents, etc.)
however, you can create a number of coordinate systems with different
projections. Then make copies of your maps and link the coordinate systems to
these copies by editing the Properties of the maps. When you subsequently
display the maps in a number of map windows and add a graticule to each map,
you can clearly see the effect of the projection used, select the favourable ones
and print these.

For an introduction to projections, see below.

Creating a coordinate system
To create a coordinate system, select the Create Coordinate System command on
the File menu of the Main window or double-click the NewCrdSys item in the

Operation-list. Furthermore, you can click the create button  in the dialog box
when creating a point, segment or polygon map, or a georeference. For more
information, refer to the Create Coordinate System dialog box.
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Editing a coordinate system
The easiest way to edit an existing coordinate system, is to double-click it in the
Catalog. Furthermore you can click a coordinate system with the right mouse
button in the Catalog and choose Open from the context-sensitive menu, use the
Edit Object command on the Edit menu in the Main window, double-click the Edit
item in the Operation-list, etc.

When a map is displayed in a map window, you can also open the Edit menu of the
map window, and choose Coordinate System.

F To show coordinate systems in the Catalog, refer to Help topic: How to customize
the Catalog.

F To view which coordinate system is used by a georeference or a point, segment or
polygon map, check the properties of the georeference or of the point, segment or
polygon map.

Technical information
A coordinate system constists of an ASCII object definition file (.CSY). This file
stores the coordinate boundaries and, if available, projection information.

By viewing the properties of a coordinate system, you can see for instance by which
vector maps and by which georeferences this coordinate system is used.

Projections
A projection defines the relation between the map coordinates (X,Y) and the
geographic coordinates latitude and longitude (f, l).

The Earth's surface is curved, however in maps it is presented as a flat surface.
Therefore, the display of an area on a map will always lead to some deformation or
distortion; there is no 'perfect' projection. If you show only a small part of the
Earth, like a town, will be almost insignificant. If, on the other hand, a map shows
a continent, deformations and distortions will be a major problem. To correctly
represent the curved Earth's surface on a flat map, you need a special projection.
The geographic coordinates are converted into metric coordinate system, measuring
the X and Y directions in meters. Each  projection has unique equations for the
transformation from geographic to metric coordinates.

Because of the earth's rotation, the shape of the earth is not a perfect sphere. The
earth is flattened towards the poles: the equatorial axis (line from the center to the
Equator) is longer than the polar axis. The shape of the earth can be represented by
an ellipsoid, or as it is sometimes called, a spheroid (shapes that are generated by
revolving an ellips around its minor axis). The choice of the ellipsoid which fits
best a certain region of the earth surface to be mapped depends on the surface
curvature and undulations in that region. Hence every country has its own 'best fit'
ellipsoid.
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General characteristics of projections

Projection types
Based on the shape of the projection surface, one can classify the projections in
azimuthal, conical and cylindrical projections. Therefore, the cone or cylinder
needs to be 'unrolled' to form a plane map.

1. Cylindrical projections
Cylindrical projections may be imagined as the projection to a plane that is
wrapped around the globe in the form of a cylinder (see Figure 1). After unrolling,
the outline of the world map would be rectangular in shape; the meridians are
parallel straight lines which cross at right angles by straight parallel lines of
latitude. Examples: Mercator, Plate Carree.

Figure 1: Principle of cylindrical projections.

2. Azimuthal projections
Azimuthal projections may be imagined as the projection on a plane tangent to the
globe (Figure 2). The characteristic outline of the world map would be circular. If
the pole is the central point, the meridians are straight lines, spaced at their true
angles intersecting at this center point. Parallels are represented as concentric
circles. Examples: Gnomonic, Stereographic.

Figure 2: Principle of azimuthal projections.

3. Conical projections
Conical projections may be imagined as the projection to a plane that is wrapped
like a cone around the globe (Figure 3). After unrolling the outline of the world
would be fan shaped. The meridians are represented as straight lines and parallels
as concentric circles. Only the parallels where the cone touches the globe has the
same length as on earth.
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Figure 3: Principle of conical projections.

Aspect
Furthermore, projections can be subdivided according to the direction in which a
cylinder, plane or cone is oriented with respect to the globe, the so-called aspect. In
the text above, it is assumed that the projection only touches the Earth. However, it
is also possible to use a secant cylinder, plane or cone which intersects the sphere.
Figures 4, 5, and 6 show some aspect types for different types of projections.
n For cylindrical projections a normal aspect is a cylinder that touches the

equator. A transverse aspect is a cylinder that touches the poles.
n Similarly the normal and secant aspects of azimuthal projections can be

visualized.
n The aspect may also be oblique; in that case the cylinder, plane or cone is not

horizontally or vertically oriented, but something in between.

Fig 4: Different aspects for cylindrical projections.

Fig. 5: Different aspects for azimuthal Fig 6: Different aspects for conical 
projections. projections.
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Projection characteristics
As mentioned before a map projection always results in some deformation or
distortion. Depending on the type of projection, these distortions will be different.
This is indicated by the characteristics of a projection:
n Conformality: a conformal map is one in which all angles are indicated

correctly. Angles between two points in a map with a conformal projection and
between two points on Earth are the same. As all angles are maintained, the
shape of the objects is also preserved. Examples: Mercator, Stereographic.

n Equivalence: a map with an equivalence property is an equal-area map.
Although the shape of objects is distorted, the areas of all regions are shown in
the same proportion to their true areas. Examples: Mollweide, Sinusoidal.

n Equidistance: an equidistance map has the characteristic that in one direction
the distances are preserved.

Available projections
Map projections are named according to the class, the aspect, the property, the
name of the originator and the nature of any modification. For an overview of
available projections, refer to Select Projection dialog box.

4.3 Special objects
Special objects are:

map views
histograms
sample sets
matrices
user-defined filters
user-defined functions
scripts

Each special object name should start with a character between A to Z. Object
names cannot exceed 8 characters.

F To have service objects appear in the Catalog, use the Catalog command on the
Options menu in the Main window. See also Help topic How to customize the
Catalog.

4.3.1 Map views
A map view stores all data and annotation layers as displayed in a map window, for
instance a raster map with a vector map, legend, north arrow, etc. together with the
display options of these layers. Saving the contents of a map window in a map view
ensures quick and easy re-display of all layers when opening the view later on.

The description you give to a map view will be visible in the title bar of the map
window. If you save a map view when zoomed in on a map, the zoomed area will
be displayed when opening the map view.
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Names of map views
Any map view name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.

To create a map view
Display the required data layers and/or annotation layers in a map window. Then,
from the File menu in the map window, select the Save View or the Save View As
command.

For more information on the creation and editing of map views, refer to How to use
layers in a map window.

To display a map view
The easiest way to display a map view is to double-click it in the Catalog. All the
maps and annotation that was stored as the map view is directly displayed in a map
window.

F To show map views in the Catalog, refer to Help topic: How to customize the
Catalog.

Technical information
A map view consists of an ASCII object definition file (.MPV). This file stores
references to all map names that were stored as the map view and further contains
the display options of all map and/or annotation layers. Furthermore, the
georeference of the map window is stored.

4.3.2 Histograms
A histogram is a dependent table which stores frequency information on values,
classes or IDs in a raster, polygon, segment or point map. A raster histogram is
automatically calculated when displaying a value raster map which is stored using
one or two bytes per pixel. Further, the Histogram operation can be used to
calculate a histogram. The values in a histogram are presented as a table. A
histogram always has the same name as the map from which it is calculated.

A raster histogram lists, depending on the domain of the map, for each value, class
name or ID, the number of pixels in the map, and for each value, class name or ID
the size of the area of these pixels as a percentage of the total area in square meters.
If the input raster map uses a Value domain, the cumulative number of pixels, the
cumulative percentages of the areas and the percentage of pixels of the total area
that are not undefined are also calculated.
Furthermore, summary information can be viewed in the properties of the
histogram such as mean, predominant value, standard deviation, and percentage
intervals.
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A polygon histogram lists, depending on the domain of the map, for each value,
class name or ID, the number of polygons, and the perimeter and the area in square
meters of these polygons. If the input polygon map uses a Value domain, the
cumulative number of polygons, cumulative perimeters and cumulative areas are
also calculated.
Furthermore, summary information is available in the properties of the histogram.
A segment histogram lists, depending on the domain of the map, for each value,
class name or ID, the number of segments and their length. If the input segment
map uses a Value domain, the cumulative number of segments and the cumulative
lengths are also calculated.
Furthermore, summary information is available in the properties of the histogram.
A point histogram lists, depending on the domain of the map, for each value, class
name or ID, the number of points. If the input point map uses a Value domain, the
cumulative number of points is also calculated.
Furthermore, summary information is available in the properties of the histogram.

Names of histograms:
A histogram always obtains the same name as the map from which it is calculated.

To calculate a histogram
You can double-click the Histogram operation in the Operation-list and select the
map from which you want to calculate a histogram. You can also click a map in the
Catalog with the right mouse button and choose Statistics, Histogram from the
context-sensitive menu. For other methods, see How to calculate a histogram.
Furthermore, a histogram is automatically calculated when you display a value
raster map (domain Image, system domain Value, another system value domain or
a user-defined value domain) which is stored using 1 or 2 bytes per pixel.

To display a histogram as a table and as a graph
The easiest way to display a histogram is to double-click a histogram in the
Catalog. To show the histogram as a graph, choose from the Options menu in the
table window the Show Graph command: choose the domain column for the X-
axis, and the Npix column for the Y-axis; then choose Needle.

F To show histograms in the Catalog, refer to Help topic: How to customize the
Catalog.

Editing a histogram
As a histogram is a dependent table, depending on the values, class names, or IDs
in a map, the values of the calculated (table-owned) columns in a histogram table
cannot be edited. You can always perform further calculations using these columns
by typing expressions on the TabCalc command line.
If you really want to manually edit the values of calculated table-owned columns,
you first have to break the dependency link of the histogram table in its Properties
dialog box.
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F For histograms of domain Class or ID maps: as the domain of the histogram is the
same as the domain of the map, all columns of the histogram can be joined to an
attribute table of a map. See also How to join areas from a histogram to an attribute
table.

Technical information
A histogram consists of an ASCII object definition file (.HIS, .HSA, .HSS or .HSP)
and a binary data file (.HI#, .HA#, .HS# or .HP#). The object definition file
contains references to the map from which the histogram was calculated and the
domain of that map. The domain of the map is is also the domain of the histogram.

By viewing the properties of a histogram, you can see whether the histogram is up-
to-date. If this is not the case, i.e. after editing the map from which the histogram
was calculated, you can easily recalculate the histogram by clicking the Make Up-
to-Date button. The properties of a value histogram also present a histogram
summary: the Mean, Standard Deviation, Median, Predominant value and the
number of times this value occurs in the map. Furthermore, the values in the map
which define the 0%, 0.5%, 1.0%, 2.0%, 5.0% and 10.0% percentage intervals in
the histogram are listed.

Limitations
The maximum number of entries in a histogram is 2 billion.

4.3.3 Sample sets  
A sample set stores training pixels for supervised classification. Prior to an image
classification, sample pixels or training pixels have to be selected in a sample set. A
map list, containing the set of images used for classification and a background map
on which you can locate training pixels and a class domain have to be specified.
Then, during sampling, class names need to be assigned to groups of pixels that are
supposed to represent a known feature on the ground and that have similar spectral
values in the maps in the map list.  A sample set is used as input in the Classify
operation.

A sample set consists of
n a reference to a map list, that is the set of images you want to classify in a later

stage. The spectral values of the images in the map list, at  the position of the
training pixels provide the basis on which decisions are made in the
classification. During sampling, these values can be inspected in the sample
statistics of a certain class of training pixels, and  can be visualized in feature
spaces. Usually, you will use a set of satellite images in the map list, but you can
also work with the Principal Components.

n a reference to a class domain, that is the collection of class names that you want
to assign to your training pixels and that are the classes that you want to obtain
from the classification. The representation of this domain determines in which
colors the training pixels are displayed during sampling. You can also add
classes to the domain during sampling, or delete or merge classes;
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n a reference to a background map, that is the map on which you can locate your
training pixels; this background map can for instance be a color composite;

n a reference to a raster map which is automatically created and obtains the same
name as the sample set. This so-called sample map contains the locations of the
training pixels and the class names assigned to them.

Names of a sample set
Any sample set name must start with a character between A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9 and underscores. Names cannot exceed 8 characters.

To create a sample set
A sample set can be created by for instance double-clicking the Sample Map item
in the Operation-list, or select Sample from the Operations menu, Image
Processing. For other methods, see How to create a sample set. The sample set
editor is opened.

Editing a sample set
The easiest way to edit an existing sample set is by double-clicking it in the
Catalog. See also, How to edit a sample set. For other methods, see How to edit a
sample set. The sample set editor is opened.

F To show sample sets in the Catalog, refer to Help topic: How to customize the
Catalog.

Technical information
A sample set consists of an ASCII object definition file (.SMS). This file contains
further references to a domain (containing the class names of sampled pixels), a
map list (containing the satellite bands), a background map, and to a raster map
that is automatically created and is stored with the same name as the sample set
which contains the locations of training pixels and class names assigned to them
(this map is called the sample map).

By viewing the properties of a sample set, you can see the domain, the name of the
sample map, the map list and background map used in the sample set. These are
properties of the sample set.

Limitations
The maximum number of raster maps that can be included in a map list is 5440; no
other limitations.
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4.3.4 Two-dimensional tables
A two-dimensional table is used to combine or reclassify two raster maps with a
class or ID domain. It defines a value for each possible combination of input classes
or IDs.

A two-dimensional table view consists of rows which represent one domain and of
columns which represent another domain. In the two-dimensional table, you have
to assign a value, class name or ID to the fields which represent the combination of
these domains.

When you apply the two-dimensional table on the command line of the Main
window, you need two input raster maps which have the domains as used by the
two-dimensional table, the output raster map then contains the values, classes or
IDs that you entered in the fields of the two-dimensional table.

To create a two-dimensional table
Open the File menu of the Main window and select the Create Two-Dimensional
Table command, or double-click the New 2DimTbl item in the Operation-list. In
the appearing Create 2-Dimensional Table dialog box, select two input domains of
raster maps on which you want to apply the two-dimensional table later on.

To display and edit a two-dimensional table
When you create a new two-dimensional table, it is directly displayed in a table
window where you can also directly edit it.

To open and edit an existing two-dimensional table, double-click a two-
dimensional table in the Catalog, double-click the Open or Edit item in the
Operation-list, or select the Edit Object command on the Edit menu of the Main
window and select a two-dimensional table.
For more information on editing a two-dimensional table, see Table window :
editing two-dimensional tables.

F To show two-dimensional tables in the Catalog, refer to Help topic: How to
customize the Catalog.

To apply a two-dimensional table
A two-dimensional table can be applied by typing a special expression on the
command line of the Main window:

OUTMAP = 2dimtablename[map1,map2]

For more information, see Map calculation : applying two-dimensional tables.

Technical information
A two-dimensional table consists of an ASCII object definition file (.TA2) and a
binary data file (.T2#).
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The object definition file contains further references to two domains that contain
the classes or IDs that you want to reclassify and to one domain which contains the
classes, IDs or values after reclassification; these three domains are properties of a
two-dimensional table (see also Appendices : relations between ILWIS objects).

Internally, a two-dimensional table uses system domain None; the table has only
one table-owned column named Value which stores the output class names, IDs or
values for each combination of input classes or IDs.

4.3.5 Matrices
In ILWIS, there are four Statistical operations which calculate a matrix:
n covariance matrix by the Variance-Covariance matrix operation;
n correlation matrix by the Correlation matrix operation;
n covariance matrix and matrix of eigenvectors by the Principal Components

operation;
n correlation matrix and matrix of eigenvectors by the Factor Analysis operation.
All these operations can be found on the Operations menu, Statistics, Map List.

As matrices are the result of an operation, matrices cannot be edited.

Names of matrices
When performing the Variance-Covariance operation or the Correlation operation,
the matrix is not stored as a separate object; the matrix is stored in the input map
list.

When performing the Principal Components or Factor analysis operation, you can
specify a name for the matrix yourself. Any matrix name must start with a
character from A to Z. For the other characters in an object name, you are allowed
to use: characters A through Z, numbers 0 through 9, and underscores. Object
names cannot exceed 8 characters.

F To show matrices in the Catalog, refer to Help topic: How to customize the Catalog.

To display a matrix
To display a covariance matrix, perform the Variance-Covariance operation.
To display a correlation matrix, perform the Correlation operation.

To display the output matrices of the Principal Components and Factor Analysis
operations:
n double-click a matrix in the Catalog, or
n use the right mouse button on a matrix in the Catalog, and select Open from the

context-sensitive menu, or
n from the File menu in the Main window, choose Open and select a matrix.
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Technical information
A matrix consists of an ASCII object definition file (.MAT).

Variance-covariance matrix:
Shows the variance and covariance values for all bands in the input map
list and the mean and standard deviation of each input map. In the
properties of the input map list the Optimum Index Factors (OIF) are
listed.

Correlation matrix:
Shows the correlation values for all bands in the input map list and the
mean and standard deviation of each input map. In the properties of the
input map list the Optimum Index Factors (OIF) are listed.

Principal components matrix:
Stores eigenvectors for the new output maps (axes) and the percentages of
total variance contributed by each eigenvalue. When the matrix is
calculated, the output maps and the output map list are created.

Factor analysis matrix:
Stores eigenvectors for the new output maps (axes) and the percentages of
total variance contributed by each eigenvalue. When the matrix is
calculated, the output maps and the output map list are created.

4.3.6 Filters
Filters are used in the Filter operation. In ILWIS, there are four main filter types:
Linear filters, Rank order filters, Majority filters, and Binary filters. Furthermore,
there is a Pattern filter and a Standard deviation filter. For an explanantion on the
working of these filter types and examples, see Filter types. For examples on the use
of filters, see Filter : functionality.

Some 30 filters are predefined in the SYSTEM directory. However, the Filter :
dialog box offers many possibilities to define most filters on the fly according to
your wishes before applying them. This can of course also be done on the command
line of the Main window. Further, your own linear filters can be created, edited and
stored on disk.

Names of filters
Any filter starts with a character from A to Z. For the other characters in an object
name, you are allowed to use: characters A through Z, numbers 0 through 9, and
underscores. Object names cannot exceed 8 characters.

To create a linear filter
You can create your own user-defined linear filter of any odd size. Easy ways to
create a new linear filter is to choose Create Filter from the File menu of the Main
window, or to double-click the New Filter item in the Operation-list. For more
information, refer to How to create a linear filter.
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To view or edit a linear filter
All linear filters can be opened to see their contents; you can edit your own user-
defined linear filters. The easiest way to view or edit a linear filter is to click it with
the right mouse button in the Catalog, then choose Open from the context-sensitive
menu. For more information, see How to edit a user-defined linear filter.

F To show filters in the Catalog, refer to Help topic: How to customize the Catalog.
F The Average filter, Majority filters, Median filters, Rank Order filters, and the

Standard Deviation filter may have a user-defined size, rank or threshold. You can
define these filters on the fly in the Filter : dialog box.

Technical information
Filters which are stored on disk consist only of an ASCII object-definition file
(.FIL). This file stores the name, type and size of the filter, and it may further store
matrix values for linear filters, the solution table for binary filters, etc.

By viewing the properties of a filter, you can see whether it is a system filter or not,
when it was last edited, object size and the description of the filter. A filter has no
relations to other objects.

Limitations
The total size of a filter (nr. of rows in the filter * nr. of columns in the filter)
cannot exceed 8000. This means that you can create filters up to 89*89, 49*
161, 9*801, 1*7999, etc.

4.3.7 Functions
A function allows you to pre-define complex calculations or calculations which
need to be repeated several times; when you use the function in a calculation, you
only need to fill out the function's parameters.

Functions can be used in all three calculators in ILWIS: MapCalc, in TabCalc, or
in the pocket line calculator. In ILWIS, some 50 internal functions are available
(see also MapCalc and TabCalc), but you can also create your own functions. By
creating a user-defined function beforehand, your MapCalc and TabCalc formulas
may be simplified.

A user-defined function may contain any combination of operators and functions,
and may use parameters representing map names, table names and column names.
Parameters in a user-defined function can have any name.

Names of user-defined functions
Any function name must start with a character from A to Z. For the other
characters in an object name, you are allowed to use: characters A through Z,
numbers 0 through 9, and underscores. Object names cannot exceed 8 characters.
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F To show user-defined functions in the Catalog, refer to How to customize the
Catalog.

To create a user-defined function
n in the Main window, open the File menu, choose Create Function, or
n double-click the New Function item in the Operation-list.

The Create Function dialog box appears in which you can type the expression that
the function should perform.

To edit a user-defined function
n in the Catalog, double-click a function, or
n in the Main window, open the Edit menu; choose Edit Object and select a

function, or
n in the Catalog, click a function with the right mouse button, and select Open

from the context-sensitive menu.

The Edit Function dialog box appears.

When creating or editing a user-defined function, you must take care that the
output domain type of the function is declared correctly; by default Value
 will appear behind the colon in the Edit Function dialog box (see also the example
below).

Parameters in user-defined functions
Normally, a function needs parameters on which it should work. This means that
you can to use parameters when defining a function. Parameters can be as long as
you like, should always start with a character from A to Z, and can only contain
characters from A to Z, numbers 0 to 9, and underscores. For each parameter, the
domain has to be specified.

To apply a function
When you use the function on the command line of the main window or a table
window, you have to type the function name followed by brackets in which you type
the map name(s) or column name(s) that need to be filled out for the parameter(s)
in the function. You can separate parameters with commas. Instead of map names
or column names, you can also type complete expressions.
The first filled in parameter is taken as the first parameter encountered in the
function, etc.

In this way, you can use the function several times, each time filling out different
map or column names on which the function should be applied.

Example of a user-defined function
To define a function SUM to sum some bands of an image, you may create a
function SUM defined as: a+b.
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In the Edit Function dialog box, this will appear as:

Function Sum(value a, value b): Value

This means that the function Sum has two parameters (a and b) which are of the
value type, and the output domain of the function is also a value.
Further, the Edit Function dialog box states the calculation that should be
performed with the parameters of the function; in this case:

Begin
Return a+b
End;
This means that parameters a and b will be summed.

When using this function on the command line, you may type:

OUT=sum(band1,band2)

OUT is the output object, 'Band1' is then used as parameter 'a' and 'band2' is
used as parameter 'b'.

File information
Functions consist of an ASCII object definition file (.FUN), and an ASCII data file
(.FND).
Internal MapCalc and TabCalc functions are built in in the software and cannot be
visualized.

Example 1 (with parameters)
To define a function SUM to sum some bands, you may create a function SUM
defined as: a+b.

In the Edit Function dialog box, this will appear as:

Function Sum(value a, value b) : Value

This means that the function Sum has two parameters (a and b) which have a value
domain;
after the colon the output domain of the function (system domain Value) is
specified. You can specify any domain you like.

Further, the Edit Function dialog box states the calculation that should be
performed with the parameters of the function; in this case:

Begin
Return a+b
End;

This means that parameters a and b will be summed.

To use this function, type on the command line:

OUT=sum(band1,band2)

Where:
OUT is the output object,
Band1 is used as parameter a, and
band2 is used as parameter b.
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Example 2 (without parameters)
To define a function AVG2B to calculate the average of two bands, you may create a
function AVG2B defined as: (TMB1+TMB2)/2.

In the Edit Function dialog box, this will appear as:

Function AVG2B(value tmb1, value tmb2) : Value

Remove the parameters between the brackets; and keep the default output domain
Value.

Function AVG2B() : Value

Further, the Edit Function dialog box states the calculation that should be
performed with the parameters of the function; in this case:

Begin
Return (tmb1+tmb2)/2;
End;

To use this function, type on the command line:

OUT=AVG2B()

where:
OUT is the output object,
AVG2B is the function which already contains the map names.

In the Raster Map Definition dialog box, you have to specify the correct
georeference for the output map.

4.3.8 Scripts
Scripts are used to perform a sequenced list of ILWIS operations. By creating a
script, you can build a complete GIS or Remote Sensing analysis for your own
research discipline. Scripts are more or less equivalent to batch files in ILWIS
version 1.4.

Lines in a script may contain commands for object management (e.g. copy or
delete), display of data objects (Open or Show), and for the creation and calculation
of data objects. All MapCalc, and TabCalc formulas, and all ILWIS expressions to
perform operations may be used. Other scripts and other Windows applications can
also be called from within a script. A script can use parameters. For more
information on valid script expressions, see Appendices : ILWIS script language
(syntax). For more information on using parameters in scripts, see How to use
parameters in scripts.

Names of scripts
Any script name must start with a character from A to Z. For the other characters
in an object name, you are allowed to use: characters A through Z, numbers 0
through 9, and underscores. Object names cannot exceed 8 characters.

To create a script
n in the Main window, open the File menu and choose Create Script, or
n in the Operation-list, double-click the item NewScript.
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The Create Script dialog box appears, in which you can type lines of expressions
for calculations and operations.

To edit a script
n in the Main window, open the Edit menu, choose Edit Object, and select a

script, or
n in the Catalog, click a script with the right mouse button, and select Open from

the context-sensitive menu.

The Edit Script dialog box appears.

F To show scripts in the Catalog, refer to How to customize the Catalog.
F When creating or editing a script, you can use the following keystrokes to copy and

paste script lines to and from the clipboard:
Ctrl+C Copy the selected part to clipboard.
Ctrl+Ins Copy the selected part to clipboard.
Ctrl+V Paste the contents of the clipboard at the position of the mouse

pointer.
Shift+Ins Paste the contents of the clipboard at the position of the mouse

pointer.

Using parameters in scripts
Parameters in a script can replace (parts of) object names, operations, etc.
Parameters in scripts work as DOS replaceable parameters in DOS batch files, and
must be written in the script as %1, %2, %3, up to %9. The parameters of a script
have to be filled out on the command line when you run the script. The first text
string found after the script name will replace %1 in the script, etc. For more
information, see How to use parameters in scripts.

To run a script
To run a script, type on the command line of the Main window:

Run scriptname  parameter  parameter

Fill out script name and parameters. The first text string found after the script name
will replace %1 in the script, etc. On the command line, script parameters are
entered without brackets and separated by spaces. If a script has no parameters, you
can directly double-click the script in the Catalog. For more information, see How
to run scripts.

Example
For example, you can create a script SumBands, defined as:
%3=%1+%2 or as
%3.mpr=%1.mpr+%2.mpr
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To apply this script, type on the command line of the Main window:

run SumBands band1 band2 OUT

'band1' is filled out for %1, 'band2' is filled out for %2, and OUT is used as the
output object name.

A more elaborate example of a script (to create slope maps in percentages and in
degrees) is presented in topic Map & Table calculation : creating and running
scripts.

Technical information
A script consists of an ASCII object definition file (.ISL, ILWIS Script Language)
and an ASCII data file (.ISF, ILWIS Script File).

4.4 Annotation
Annotation can be added to a map window in the form of texts, legends, boxes,
North arrow, scale bar, grid lines, graticule, or bitmaps or metafiles (pictures) from
disk. Furthermore, any picture or bitmap that was copied to the clipboard from
other Windows application programs can be pasted into ILWIS. You can also paste
the contents of another ILWIS map window as annotation into a current map
window; for instance as an inset-map giving an overview of a larger area.

Annotation is generally used on top of one or more data layers (displayed maps).
Annotation can be edited in the Annotation editor. To store annotation, you need to
save the map window as a map view.

Creating annotation
There are several ways to add annotation to a map window:
n from the Layers menu, choose Add Annotation, and select the type of

annotation you want, or
n from the Layers menu, choose Layer Management. In the appearing Layer

Management dialog box click the Add Annotation button, and select the type of
annotation you want, or

n from the Edit menu, choose Annotation. The Annotation editor is opened
directly.

Before annotation is shown, you have to specify some display options for the
annotation layer. Then, the Annotation editor is opened. In the Annotation editor,
you can use the same possibilities as above, but you can also click one of the add
annotation buttons in the button bar (the status line gives an explanation).
For more information, see also How to add annotation to a map window.

Editing annotation
You can edit annotation in the Annotation editor. To open the Annotation editor,
choose the Annotation command on the Edit menu of a map window. The
Annotation editor is automatically started when a new annotation layer is added to
a map window.
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In the Annotation editor, texts, legends, boxes, scale bar, North arrow, and bitmaps
or pictures can be moved to another position by drag and drop. The size of these
types of annotation can be adjusted by dragging the size handles of a selected
object. Further, the display options of these types of annotation can be changed by
double-clicking. Grid lines and a graticule have a fixed position in a map window
according to the georeference of the map window and can thus not be moved or
double-clicked. You can always change display options of an annotation layer by
choosing the Display Options command from the Layers menu, or through Layer
Management. For more information, refer to the Annotation editor or to How to
edit annotation.

F To create more space in a map window for annotation, select the Extend Window
command on the Options menu.

Saving annotation
Annotation should be saved with the contents of your map window as a map view.
Either in the Annotation editor or in the map window, open the File menu, and
choose the Save View or the Save View As command. All annotation layers and all
data layers in the map window are stored with their current display settings. Specify
a name for the map view and a title. The title will appear in the title bar when you
redisplay the map view.

Annotation types

Text
Texts such as titles can be added as annotation to a map window. Texts can be
rotated, font and colors are user-defined. A text can be as long as you like and you
can add as many texts as you like to a map window.
If you want to obtain (texts) labels of points, display the point map as an extra data
layer in the map window: select the Text check box on the Display Options dialog
box of the point map. If you want to obtain (text) labels for segments or polygons,
use the Segments to Points or Polygons to Points operation, then display the output
point map as an extra data layer in the map window.

Legend
A legend can be added as annotation to a map window. A legend can be created for
maps using a class domain, the image domain or a value domain. Legends are more
or less automatically created from the domain that a map is using and from the
representation used by that domain.

Class legend:
For a legend of a class map, color boxes and class names appear in principle for all
items in the class domain.
The user can hide class names from the legend and manipulate the order in which
class names appear in the legend. Further, font and text color are user-defined and
a legend can be made transparent or not.
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Value legend:
For a legend of an image or a value map, a vertical color bar with gradual colors as
used in the displayed map is automatically created. Font and color for the text
explaining some of the colors in the color bar are user-defined, and a legend can be
made transparent or not.

North-arrow
A North-arrow determines the North of a map from the georeference that is used by
a displayed raster map, or when no raster map is displayed, from the coordinate
system used by displayed vector maps. Three types of North arrows are available,
line width and color are user-defined. Text such as N, E, S, W can be displayed
with the North arrow. Font and color for the text are user-defined.

Scale bar and scale information
A scale bar and scale information (e.g. 1 : 100000) can be shown based on the
georeference that is used by a displayed raster map, or when no raster map is
displayed, on the coordinate system used by displayed vector maps.
A scale bar can be prepared in two forms: as blocks of alternating colors or as a line
with tick marks. The distance intervals and colors used in the scale bar are user-
defined. Font and colors used for the text below the scale bar and for scale
information is also user-defined.

When you display scale information, the value may seem odd in the map window,
however, when you print the map on a certain scale, the scale value is automatically
adjusted to the scale that you selected for printing.

Box
Boxes can be used to obtain borders around the whole mapped area, around a
legend, or a title, etc. Two types of boxes are available, line width and color of the
border of the box are user-defined. If line width 1 is selected, also three different
line styles are available. By default, the inside of a box is transparant, but you can
also fill a box with a color.

Grid lines
Grid lines, coordinate ticks, X- and Y-coordinates and a border fitting a map can be
shown. Grid lines are regularly spaced usually horizontal and vertical lines based
on the georeference of the map window. The spacing of grid lines is specified in
meters and also line width and color are user-defined. X- and Y-coordinates of the
grid lines can be shown inside or outside the map area, and can appear in a short
form. Font and color for the coordinate text are user-defined.

Graticule
A graticule consists of lines that follow longitude and latitude of a geographic
projection as used by a coordinate system. Thus, to create a graticule, you need to
display a map using a coordinate system that has projection information. The
spacing of a graticule is specified in degrees, minutes and seconds, further line
width and color are user-defined.
Latitudes and Longitudes of the graticule cannot be shown yet as text.
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Bitmaps from disk
A bitmap is a standard Windows graphic file format in 'raster' form. Bitmaps can
be added as annotation to an ILWIS map window. Bitmaps are stored in device
independent bitmap (dib) format, i.e. bitmaps are not dependent on the graphic
board. Bitmaps can use a 2, 16, 256 color palette, or are stored using 24 bits per
pixel. The default file extension for bitmaps is .BMP.

When using 256 color bitmaps, and when a lot of windows with many colors are
open already, you may loose the colors of pasted bitmaps. When this occurs, you
might consider using 16 color bitmaps.

Windows metafile or pictures from disk
A Windows metafile, often called a picture, is a standard Windows graphic file
format in 'vector' form. Metafiles or pictures can be added as annotation to an
ILWIS map window. A metafile consists of a set of Windows drawing instructions.
The default extension for Windows metafiles is .WMF.

ILWIS maps as inset-maps in other map windows
Prepare an ILWIS map as usual, copy it into the clipboard and paste as a picture
into another ILWIS map window. The pasted layer is an annotation layer.

Pasting pictures and bitmaps from clipboard
Any picture or bitmap in the clipboard (copied into the clipboard from any
Windows application), can be pasted into an ILWIS map window. You can use the
clipboard viewer in Windows to view what is in the clipboard. For more
information, see Copying and pasting through the clipboard, and  Appendices :
Keyboard shortcuts.




